
 

August 2008 64-0353-01 

www.dialogic.com 

Dialogic® 4000 Media Gateway Series 

Integration Note 
Nortel Option 11c 

 
 



 

2 

Copyright and Legal Notice 
Copyright © 2008 Dialogic Corporation. All Rights Reserved. You may not reproduce this document in whole or in part without permission in 

writing from Dialogic Corporation at the address provided below. 

All contents of this document are furnished for informational use only and are subject to change without notice and do not represent a 

commitment on the part of Dialogic Corporation or its subsidiaries (“Dialogic”). Reasonable effort is made to ensure the accuracy of the 

information contained in the document. However, Dialogic does not warrant the accuracy of this information and cannot accept responsibility 

for errors, inaccuracies or omissions that may be contained in this document. 

INFORMATION IN THIS DOCUMENT IS PROVIDED IN CONNECTION WITH DIALOGIC® PRODUCTS. NO LICENSE, EXPRESS OR IMPLIED, BY 

ESTOPPEL OR OTHERWISE, TO ANY INTELLECTUAL PROPERTY RIGHTS IS GRANTED BY THIS DOCUMENT. EXCEPT AS PROVIDED IN A 

SIGNED AGREEMENT BETWEEN YOU AND DIALOGIC, DIALOGIC ASSUMES NO LIABILITY WHATSOEVER, AND DIALOGIC DISCLAIMS ANY 

EXPRESS OR IMPLIED WARRANTY, RELATING TO SALE AND/OR USE OF DIALOGIC PRODUCTS INCLUDING LIABILITY OR WARRANTIES 

RELATING TO FITNESS FOR A PARTICULAR PURPOSE, MERCHANTABILITY, OR INFRINGEMENT OF ANY INTELLECTUAL PROPERTY RIGHT OF 

A THIRD PARTY. 

Dialogic products are not intended for use in medical, life saving, life sustaining, critical control or safety systems, or in nuclear facility 

applications. 

Due to differing national regulations and approval requirements, certain Dialogic products may be suitable for use only in specific countries, 

and thus may not function properly in other countries. You are responsible for ensuring that your use of such products occurs only in the 

countries where such use is suitable. For information on specific products, contact Dialogic Corporation at the address indicated below or on 

the web at www.dialogic.com. 

It is possible that the use or implementation of any one of the concepts, applications, or ideas described in this document, in marketing 

collateral produced by or on web pages maintained by Dialogic may infringe one or more patents or other intellectual property rights owned 

by third parties. Dialogic does not provide any intellectual property licenses with the sale of Dialogic products other than a license to use 

such product in accordance with intellectual property owned or validly licensed by Dialogic and no such licenses are provided except 

pursuant to a signed agreement with Dialogic. More detailed information about such intellectual property is available from Dialogic’s legal 

department at 9800 Cavendish Blvd., 5th Floor, Montreal, Quebec, Canada H4M 2V9.  

Dialogic encourages all users of its products to procure all necessary intellectual property licenses required to implement any 

concepts or applications and does not condone or encourage any intellectual property infringement and disclaims any 

responsibility related thereto. These intellectual property licenses may differ from country to country and it is the 

responsibility of those who develop the concepts or applications to be aware of and comply with different national license 

requirements.  

Dialogic, Dialogic Pro, Brooktrout, Cantata, SnowShore, Eicon, Eicon Networks, Eiconcard, Diva, SIPcontrol, Diva ISDN, TruFax, Realblocs, 

Realcomm 100, NetAccess, Instant ISDN, TRXStream, Exnet, Exnet Connect, EXS, ExchangePlus VSE, Switchkit, N20, Powering The Service-

Ready Network, Vantage, Making Innovation Thrive, Connecting People to Information, Connecting to Growth and Shiva, among others as 

well as related logos, are either registered trademarks or trademarks of Dialogic. Dialogic's trademarks may be used publicly only with 

permission from Dialogic. Such permission may only be granted by Dialogic’s legal department at 9800 Cavendish Blvd., 5th Floor, Montreal, 

Quebec, Canada H4M 2V9. Any authorized use of Dialogic's trademarks will be subject to full respect of the trademark guidelines published 

by Dialogic from time to time and any use of Dialogic’s trademarks requires proper acknowledgement.  

Microsoft and Windows are registered trademarks of Microsoft Corporation in the United States and/or other countries. Other names of 

actual companies and products mentioned herein are the trademarks of their respective owners. 

This document discusses one or more open source products, systems and/or releases. Dialogic is not responsible for your decision to use 

open source in connection with Dialogic products (including without limitation those referred to herein), nor is Dialogic responsible for any 

present or future effects such usage might have, including without limitation effects on your products, your business, or your intellectual 

property rights. 

 



Dialogic® 4000 Media Gateway Series Integration Note  

3 

1. Scope 
 
This document is intended to detail a typical installation and configuration of the Dialogic® 4000 Media Gateway 
Series if used to interface between a PBX and the Microsoft® Office Communications Server (OCS) application. 
 
2. Configuration Details 
 
Listed below are details of the PBX and gateways used in the testing on which this document is based. 
 
2.1 PBX 
 

PBX Vendor Nortel 

Model(s) Option 11c 

Software Version(s) Release 25 

Additional Notes N/A 

 
2.2 Gateway 
 

Gateway Model Dialogic® 4000 Media Gateway Series 

Software Version(s) Dialogic® Diva® System Release software version 8.3.2 build 459 
(formerly called Diva® Server software) 

Dialogic® Diva® SIPcontrol™ Software version 1.6 build 46 
(DSSIPControl.msi) 

Protocol T1 Q.SIG 

 
2.3 System Diagram 
 
The diagram below details the setup used in the testing and creation of this document. In the diagram, the 
abbreviation DMG4000 stands for the Dialogic® 4000 Media Gateway Series and OCS Server stands for 
Microsoft® Office Communications Server (OCS) 2007. 
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PBX DMG4000

T1/E1

IP LAN

OCS Server

OCS Clients
6100         6101

TDM Stations
7400         7401

 
 
3. Prerequisites  
 
 
3.1 PBX Prerequisites 
 
The PBX must have all supplemental service packages installed for the Q.SIG protocol to operate properly and 
to provide all advanced supplemental services. 
 
Listed below is a table of required software packages: 
 

Package Name Package Number 

End to End Signaling package (EES)   10 

Integrated Message System package (IMS)   35 

Message Waiting Center package (MWC)   46 

ISDN Signaling package (ISDN)   145 

Advanced ISDN Network Services (NTWK) 148 

1.5 Mb Primary Rate Access package (PRA)    146 or 

2.0 Mb Primary Rate Interface package (PRI2) 154 

International Primary Rate Interface package (IPRA)   202 

Message Waiting Indication (MWI)   219 

Multi Purpose Serial Data Link package (MSDL) 222 
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QM reference signaling point Interface package (QSIG)   263 

QSIG Generic Functional protocol package (QSIGGF)   305 

QSIG Supplementary Services package  (QSIG-SS)   316 

MCDN End to End Transparency package (MEET) 348 

 
3.1.1 PBX Equipment Required 
 
To support the T1 Q.SIG configuration as documented you need the DTI/PRI – NTAK09BA  interface card. 
  
3.1.2 PBX Cabling Requirements 
 
The cabling for Q.SIG connections must be CAT5e or better. A standard voice quality cable will not provide the 
desired signal quality and will cause the gateway to have issues establishing a connection on the D-channel. 
 
3.2 Gateway Prerequisites 
 
The gateway needs to support a T1 Q.SIG interface. 
 
4. Summary of Limitations 
 
No limitations noted as of the last update to this document. 
 
5. Gateway Setup Notes 
 
Steps for setting up the gateway: 
 

1. Configuration of the Dialogic® Diva® Media Board drivers. 
2. Configuration of the Dialogic® Diva® SIPcontrol™ software. 

 
5.1 Dialogic® Diva® Media Board Configuration 
 
The Diva Media Boards are configured in the Dialogic® Diva® Configuration Manager. To open the Configuration 
Manager, click:  
 
Start > Programs > Dialogic Diva > Configuration Manager. 
 
Note: In the Dialogic® Diva® software and documentation, Diva Media Boards are referred to as Diva Server 
adapters. 
 
A screen similar to the one below will appear. 
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Note: The number of TDM circuits varies depending on the used Dialogic® Media Gateway model. 
 
For this setup:  

• Set the property Switch Type to Q-SIG T1. 
• If your PBX does not provide ring tones to callers from TDM, set the property Generate Ring 

Tones to Yes.  
 
To activate the change, click File > Activate. 
 
Make these configuration changes for each TDM circuit you are going to use on the Dialogic® Media Gateway. 
 
5.2 Dialogic® Diva® SIPcontrol™ Software Gateway Application 
 
The Diva SIPcontrol software is configured via the web based interface. To open the web interface, click Start 
> Dialogic Diva > SIPcontrol Configuration.  
 
On the main page, click the SIPControl link to display the different configuration menus.  
The PSTN Interface Configuration section should automatically include all ports detected in the system. 
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Note: If you do not see any detected ports, you may need to add http://127.0.0.1 as a trusted site. From 
Microsoft® Internet Explorer, click Tools > Internet Options > Security > Trusted Sites. Use 
http://127.0.0.1:10005 to get to the configuration. 
 
In order for the Diva SIPcontrol software to route calls, the proper routes must be created and configured. Each 
route consists of a source interface and a destination interface. PSTN controllers and SIP peers are considered 
either a source interface or a destination interface depending on the call direction. 
 
 
5.2.1 PSTN Interface and Network Interface Configuration 
 
The following is a typical configuration.  
 

 
 
The Network Interface Configuration will be used by the Diva SIPcontrol software for listening to the 
SIP traffic from Microsoft® Mediation Server. Given that on these gateways the Microsoft® Mediation Server 
component and the Diva SIPcontrol software are running in the same system, you will need to change SIP 
Listen port to 9803 or to an available un-used port. Later during the Microsoft® Mediation Server 
configuration, you will need to set the PSTN Gateway next hop setting to 9803 to match.  
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5.2.2 SIP Peer Configuration 
 
Create one SIP peer to talk to Microsoft® Mediation Server as shown below. 
 

 
 
5.2.3 Routing Configuration 
 
In the Routing Configuration section, you must create two routes, one for the inbound direction (TDM to 
IP) and one for the outbound direction (IP to TDM). Once you have created the routes, click the Save button for 
the changes to take effect. 
 

 
 
5.2.4 Number Normalization 
 
The Dialplan Configuration and Address Map Configuration sections are used for manipulating dial 
numbers. For most PBX dialplans, an address map is required. See the following examples. 
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5.2.4.1 Dialplan Configuration Example 
 
To create a dialplan, click Add from the Dialplan Configuration. The following screens show how to set up 
a dialplan for a Microsoft® Office Communications Server (OCS) 2007 application with the following dialplan from 
the PBX. (This may not match to the PBX programming in section 6 and the Setup in section 2.3). 
 
Area code: 716 
Base number: 639 
Extensions: 4 digits 
Access code: 9 
 

 
 
Complete the settings and click OK. 
For the dialplan to be applied to outbound calls, click the Details button of the PSTN controller and configure 
the Address Normalization settings as shown in the screen below. This converts the dialed numbers into 
the format based on the dialplan for the PBX. If the dialed number is for an internal user, it is converted into a 4-
digit extension. If the called number is for a national call, 91 is prepended. Click OK on this page, and Save on 
the next page for the changes to take effect. 
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For the dialplan to be applied to inbound calls, click the Details button of the configured SIP peer and 
configure the Address Normalization settings as in the screen below. This converts the phone number into 
the E.164 format as needed by Microsoft® Office Communications Server 2007. Click OK on this page, and Save 
on the next page for the changes to take effect. 
 

 
 
 
5.2.4.2 Address Map Configuration Example 
 
If the dialplan does not meet your setups special requirements, the Address Map Configuration can be 
used. An address map entry uses regular expressions (RegEx) (so does Microsoft® Office Communications 
Server 2007) for converting the call address format for inbound or/and outbound direction. 
 
Important note before applying regular expression rules in address maps: The call address for outbound calls (IP 
to TDM) includes a “@hostname” part. For example, +17166391234@DMG4000.bufocs.local is the call address, 
not just +17166391234. For inbound calls (TDM to IP), the call address is the called or calling number, with a 
possible prefix “+”, “N”, or “S”. For example, an inbound call has called number 1234 with ISDN type of 
numbering flag set to Subscriber, and the calling number 49715233334444 with ISDN type of numbering flag 
set to International. The called address will be S1234 and the calling address will be +49715233334444.  
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If the ISDN type of numbering flag is set to National, the prefix “N” will be used with the call number. If the type 
is Unknown, no prefix is used. 
 
Outbound call example using address maps:  
 
Microsoft® Office Communications Server 2007 sends the E.164 dial number format to the SIP gateway. Both 
called and calling numbers need to be converted into a format that the PBX can accept. If the same PBX 
dialplan as in the previous section is used, the following conversions are needed. 
 
Calling number From Microsoft® OCS To PBX 
Internal  +1716639xxxx 716639xxxx 
 
Called number From Microsoft® OCS To PBX 
To Internal  +1716639xxxx xxxx 
To National  +1xxxxxxxxxx 91xxxxxxxxxx 
To International  +xxx…xxx +xxx…xxx 
 
Below is RegEx for the conversion tables above. 
 
Sub rule name Expression Format Stop on match 
Calling number ^\+1(716639\d{4}) $1 Not checked 
Called - Internal ^\+1716639(\d{4}) $1 Checked 
Called - National ^\+1 91 Checked 
Called - International ^\+ 9011 Checked 
 
Below are the configured address maps for outbound calls. The order of the below four sub rules and the stop 
on match check mark are relevant:   
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The following screen shows the first sub rule that converts the E.164 calling number into a  
10-digit national number: 
 

 
 
The following screen shows the second sub rule that converts E.164 for the internal called number into a 4-digit 
extension: 
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The following sub rule converts the E.164 national number into a 10-digit national number with prefix 91: 
 

 
 
The following example converts international call numbers: 
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Once an address map rule is created, it can be applied in three different places. To ease the configuration and 
troubleshooting processes, apply the rule on the outbound route as shown below: 
 

 
 
 
Inbound call example using address map: 
 
This example assumes that the PBX sends inbound calls using a 4-digit extension, with the ISDN type of number 
flag set to Subscriber for internal numbers, National for national calls, and International for 
international calls. 
 
Called number From PBX To Microsoft® OCS 
Internal xxxx (with subscriber type of number) +1716639xxxx 
 
Calling number From PBX To Microsoft® OCS 
Calling from internal xxxx (with subscriber type of number) +1716639xxxx 
Calling from national xxxxxxxxxx (with national type of number) +1xxxxxxxxxx 
Calling from international xxx…xxx (with international type of number) +xxx…xxx 
 
Sub rule name Expression  Format Stop on match 
Called ^S(\d{4})$ +1716639$1 Not checked 
Calling - internal ^S(\d{4})$ +1716639$1 Checked 
Calling - national  ^N(\d{10})$ +1$1 Checked 
Calling - international ^\+ + Checked 
 
Create an address map named Inbound and its four sub rules as shown below: 
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Apply the address map inbound rule on the inbound route as follows: 
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5.2.5 Restarting the Dialogic® Diva® SIPcontrol™ Software 
 
Note: A restart of the Diva SIPcontrol software service is needed only if the setting under Network Interface 
is changed.  
 
Save the configuration and restart the Diva SIPcontrol software service for the changes to take effect. To do so, 
click Service Status on the left hand side of the main configuration page, and then click Restart 
SIPcontrol. The Last operation log will show that the service has been stopped and started again. 
 
 
6. PBX Setup Notes 
 
The basic steps of setting up the PBX for use with this Dialogic® 4000 Media Gateway Series (DMG4000 
Gateway) and a voice processing system are as follows: 
 

1. Configuring the D-channel. 
2. Configuring the route data block. 
3. Adding the trunk members to the D-channel. 
4. Enabling the hardware and D-channel. 
5. Defining a route list and coordinated dialing plan. 
6. Setting up the subscribers stations. 

 
The PBX programming is done via a serial terminal connected to the PBXs administration port. 
 
The basic commands you will encounter on the PBX to perform these actions are: 
 
Add D-Channel      LD17 
Add Route Data Block      LD16 
Add Trunk Members      LD14 
Enable MSDL card      LD96 
Enable D-Channel      LD96 
Define Route List      LD86 
Define Coordinated Dialing Plan    LD87 

 
6.1 Configuring the D-Channel 
 
Add the D-channel (ADAN) using overlay LD17. Several of the fields require site specific entries; these 
are: 
 

• ADAN requires a D-channel number that is independent of other d-channel numbers on the 
switch. 

• CDNO and DCHL require an independent trunk access code number. 
 
The fields of this overlay that must be modified in this step are: 
 
TYPE, ADAN, CTYP, CDNO, DES, USR, IFC, PINX, ISDN_MCNT, CLID, DCHL, SIDE.   
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The programming example below shows how to configure a D-channel using LD17. For all other fields not noted 
in the example, press RETURN to use default values. 
 
 
REQ  chg 
TYPE cfn 
ADAN new dch 1 
CTYP msdl 
CDNO 1 
PORT 1 
DES 
USR  pri 
IFC  isgf 
PINX_CUST 0 
ISDN_MCNT 300 
CLID opt0 
DCHL  
PRI 
OTBF 
DRAT 
SIDE net 
CNEG 
RLS 
RCAP COLP NDI CCBI DV3I CTI 
OVLR 
OVLS 
MBGA 
TIMR 
LAPD 
 
 

• At the prompt REQ, enter CHG to change an entry in the configuration record and press RETURN. 
• At the prompt ADAN, enter NEW DCH XX and press RETURN. 

o xx represents an available D-channel number.  
• At the prompt CTYP, enter MSDL and press RETURN. 
• At the prompt CDNO, enter XX and press RETURN. 

o xx represents the card slot location of the T1 card. 
• At the prompt DES, enter XX and press RETURN. 

o xx represents is any name designation for the T1. 
• At the prompt USR, enter PRI press RETURN. 
• At the prompt IFC, enter ISGF press RETURN. 
• At the prompt PINX_CUST, enter 0 press RETURN. 
• At the prompt ISDN_MCNT, enter 300 press RETURN. 
• At the prompt CLID, enter OPT0 press RETURN. 
• At the prompt DCHL, enter XX and press RETURN. 

o xx represents the card slot location of the T1 card. 
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• At the prompt SIDE, enter NET to set the PBX to the network side of the connection and press RETURN. 
 
 
6.2 Configuring the Route Data Block 
 
Add the trunk route data block (RDB) using overlay LD16. In this overlay several of the fields require site 
specific entries; these are: 
 

• ROUT requires a route number that is independent of other route numbers on the switch. 
• ACOD requires an independent trunk access code number.   

 
 
The fields of this overlay that must be modified in this step are: 
 
ROUT, DES, TKTP, ESN, CNVT, SAT, RCLS, DTRK, BRIP, DGTP, ISDN, MODE, IFC, PNI, 
CHTY, CTYP, INAC, CPFXS, DAPC, INTC, DSEL, PTYP, AUTO, DNIS, DCDR, ICOG, SRCH, 
TRMB, ACOD, CLEN, TCPP, BILN, SIGO, DRNG, CDR, MUS, RACD, OHQ, OHQT, CBQ, AUTH, 
TBL, PLEV, ALRM.   
 
The programming example below shows how to configure the Route Data Block using LD16.  For all other fields 
not noted in the example, press RETURN to use default values. 
 
 
REQ  new 
TYPE rdb 
CUST 0 
DMOD 
ROUT 10 
DES  1 
TKTP pri 
TKTP pra 
TKTP tie 
ESN  no 
CNVT no 
SAT  no 
RCLS ext 
DTRK yes 
BRIP no 
DGTP pra 
DGTP pri 
ISDN YES 
MODE pra 
IFC  isgf 
PNI  00000 
CHTY bch 
CTYP ukwn 
INAC no 
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CPFXS  yes 
DAPC no 
INTC  no 
DSEL vod 
PTYP pri 
AUTO no 
DNIS no 
DCDR no 
IANI 
ICOG iao 
SRCH rrb 
TRMB yes 
STEP 
ACOD 7000 
CLEN 1 
TCPP no 
TARG 
BILN no 
SGRP 
OABS 
INST 
IDC 
ANTK 
SIGO std 
CNTL 
DRNG no 
CDR  no 
MUS  no 
RACD no 
FRL 
OHQ  no 
OHQT 00 
CBQ  no 
AUTH no 
TTBL 0 
ATAN 
PLEV 2 
ALRM no 
 
 

• At the prompt REQ, enter NEW and press RETURN. 
• At the prompt TYPE, enter RDB and press RETURN. 
• At the prompt CUST, enter XX and press RETURN. 

o xx represents the defined customer number. 
• At the prompt DMOD, press RETURN. 

At the prompt ROUT, enter XX and press RETURN. 
o xx represents an available route number. 
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• At the prompt DES, enter XX and press RETURN. 
o xx represents any name designation for the trunk route. 

• At the prompt TKTP, enter TIE and press RETURN. 
• At the prompt ESN, enter NO and press RETURN. 
• At the prompt CNVT, enter NO and press RETURN. 
• At the prompt SAT, enter NO and press RETURN. 
• At the prompt RCLS, enter EXT and press RETURN. 
• At the prompt DTRK, enter YES and press RETURN. 
• At the prompt BRIP, enter NO and press RETURN. 
• At the prompt DGTP, enter PRI and press RETURN. 
• At the prompt ISDN, enter YES and press RETURN. 
• At the prompt MODE, enter PRA and press RETURN. 
• At the prompt IFC, type ISGF and press RETURN. 
• At the prompt PNI, enter 00000 and press RETURN. 
• At the prompt CHTY, enter BCH and press RETURN. 
• At the prompt CTYP, enter UKWN and press RETURN. 
• At the prompt INAC, enter NO and press RETURN. 
• At the prompt CPFXS, enter YES and press RETURN. 
• At the prompt DAPC, enter NO and press RETURN. 
• At the prompt INTC, enter NO and press RETURN. 
• At the prompt DSEL, enter VOD and press RETURN. 
• At the prompt PTYP, enter PRI and press RETURN. 
• At the prompt AUTO, enter NO and press RETURN. 
• At the prompt DNIS, enter NO and press RETURN. 
• At the prompt DCDR, enter NO and press RETURN. 
• At the prompt ICOG, enter IAO and press RETURN. 
• At the prompt SRCH, enter RRB and press RETURN. 
• At the prompt TRMB, enter YES and press RETURN. 
• At the prompt ACOD, enter XXXX and press RETURN. 

o xxxx represents an available trunk access code number having the same length as the phone 
extension numbers. 

• At the prompt CLEN, enter 1 and press RETURN. 
• At the prompt TCPP, enter NO and press RETURN. 
• At the prompt BILN, enter NO and press RETURN. 
• At the prompt SIGO, enter STD and press RETURN. 
• At the prompt DRNG, enter NO and press RETURN. 
• At the prompt CDR, enter NO and press RETURN. 
• At the prompt MUS, enter NO and press RETURN. 
• At the prompt RACD, enter NO and press RETURN. 
• At the prompt OHQ, enter NO and press RETURN. 
• At the prompt OHQT, enter 00 and press RETURN. 
• At the prompt CBQ, enter NO and press RETURN. 
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• At the prompt AUTH, enter NO and press RETURN. 
• At the prompt TTBL, enter 0 and press RETURN. 
• At the prompt PLEV, enter 2 and press RETURN. 
• At the prompt ALRM, enter NO and press RETURN. 

 
6.3 Adding Trunk Members to the D-Channel 
 
Now that the trunk and D-channel have been created, you must assign each member of the trunk to this route 
group using overlay LD14.  
 
The fields of this overlay that must be modified in this step are: 
 
TYPE, TN, CUST, CDEN, TRK, PCML, NCOS, RTMB, TGAR, AST, IAPG, CLS.   
 
The programming example below shows how to add trunk members to the D-channel using LD14. This needs to 
be repeated for each B-channel you are adding to the D-channel (23 times per span). For all other fields not 
noted in the example, press RETURN to use default values. 
 
 
REQ  new 
TYPE tie 
TN   1 1 
DES 
PDCA 
PCML 
CUST 0 
NCOS 0 
RTMB 10 1 
B-CHANNEL SIGNALING 
MNDN 
TGAR 1 
AST 
CLS  unr dtn 
TKID 
 
 

• At the prompt TYPE, enter TIE and press RETURN. 
• At the prompt TN, enter XX XX and press RETURN.  

o xx xx represents the slot and port number of each channel of the T1 hardware. 
• At the prompt CUST, enter XX and press RETURN. 

o xx represents the defined customer number. 
• At the prompt CDEN, press RETURN. 
• At the prompt TRK ,enter PRI and press RETURN. 
• At the prompt PCML, press RETURN. 
• At the prompt NCOS, enter 0 and press RETURN. 
• At the prompt RTMB, enter XX XX and press RETURN. 
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o xx xx represents the route number and member defined previously in LD16. 
•  At the prompt TGAR, enter 1 and press RETURN. 
• At the prompt AST, enter NO and press RETURN. 
• At the prompt IAPG, enter 0 and press RETURN. 
• At the prompt CLS, enter UNR DTN and press RETURN. 

 
6.4 Enable the MSDL Board and D-Channel 
 
To use the newly added card and D-channel you need to enable both of them using overlay LD96. 
 

• Enter the command enl msdl xx and press RETURN. 
o xx represents the D-channel number defined in LD17.  

• Enter the command enl dch xx and press RETURN. 
o xx represents the D-channel number assigned in LD17.  

 
6.5 Define a Route List 
 
Use overlay LD86 to define a route list. 
 
The fields of this overlay that must be modified in this step are: 
 
REQ, CUST, FEAT, RLI, ENTR, LTER, ROUT, TOD, CNV, EXP, FRL, DMI, FCI, FSNI, OHQ, 
CBQ, ISET, MFRL, OVLL.   
 
The programming example below shows how to define a rout list using LD86. For all other fields not noted in the 
example, press RETURN to use default values. 
 
 
>ld 86 
ESN000 
REQ  new 
CUST 0 
FEAT 
FEAT rlb 
RLI  10 
ENTR 0 
LTER no 
ROUT 10 
TOD 
CNV  no 
EXP  no 
FRL  0 
DMI  0 
FCI  0 
FSNI 0 
SBOC 
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OHQ  no 
CBQ  no 
ENTR 
ISET 0 
NALT 
MFRL 0 
OVLL 0 
 
 

• At the prompt REQ, enter NEW and press RETURN. 
• At the prompt CUST, enter XX and press RETURN. 

o xx represents the defined customer number. 
• At the prompt FEAT, enter RLB and press RETURN. 
• At the prompt RLI, enter X and press RETURN. 

o x represents the next available route list index number. 
• At the prompt ENTR, enter X and press RETURN. 

o x represents the entry number for the NARS/BARS route list. 
• At the prompt LTER, enter NO and press RETURN. 
• At the prompt ROUT, enter X and press RETURN. 

o x represents the route number defined in the previous steps  
• At the prompt CNV, enter NO and press RETURN. 
• At the prompt EXP, enter NO and press RETURN. 
• At the prompt FRL, enter 0 and press RETURN. 

o where Facility restriction level (FRL) it should be set as low as possible. 
• At the prompt DMI, enter 0 and press RETURN. 
• At the prompt FCI, enter 0 and press RETURN. 
• At the prompt FSNI, enter 0 and press RETURN. 
• At the prompt OHQ, enter NO and press RETURN. 
• At the prompt CBQ, enter NO and press RETURN. 
• At the prompt ISET, enter 0 and press RETURN. 
• At the prompt MFRL, enter 0 and press RETURN. 
• At the prompt OVLL, enter 0 and press RETURN. 

 
6.6  Defining the Coordinated Dialing Plan 
 
Use overlay LD87 to define your CDP (Coordinated Dialing Plan). This is the method used in order to access the 
trunk as a forwarding point for station sets using an extension number.  
 
The fields of this overlay that must be modified in this step are: 
 
REQ, CUST, FEAT, TYPE, DSC, FLEN, DSP, RLI.   
 
The programming example below shows how to define a CDP using LD87. For all other fields not noted in the 
example, press RETURN to use default values. 
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>ld 87 
ESN000 
REQ  new 
CUST 0 
FEAT cdp 
TYPE dsc 
DSC  6 
FLEN 4 
DSP  lsc 
RLI  10 
NPA 
NXX 
DSC 
 
 

• At the prompt REQ, enter NEW and press RETURN. 
• At the prompt CUST, enter XX and press RETURN. 

o xx represents the defined customer number. 
• At the prompt FEAT, enter CDP and press RETURN. 
• At the prompt TYPE, enter DSC and press RETURN. 
• At the prompt DSC, enter XXXX and press RETURN. 

o xxxx represents the extension you want to use to access the trunk route list. 
• At the prompt FLEN, enter X and press RETURN. 

o x represents the length of the extensions in this CDP. 
• At the prompt DSP ,enter LSC and press RETURN. 
• At the prompt RLI, enter X and press RETURN. 

o x represents the rout list index created in LD86. 
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7. Microsoft® Office Communications Server 2007 (OCS) Setup 
 
 
7.1 Steps for configuring Microsoft® OCS 
 
Normalization rules are used to convert dial numbers into full E.164 formatted numbers. Microsoft® OCS uses 
the standard E.164 format to search for users listed in the Active Directory (AD).  
 
If a Microsoft® OCS user dials an internal extension number (normally 3-5 digits), the normalization rules convert 
it into full E.164 format. These normalization rules should cover dialed digits for internal extensions, local 
numbers, long distance numbers, and international numbers. 
 
To configure Microsoft® OCS, click  
Start > Programs > Administrative Tools > OCS 2007. 
 
On the tree presented in the configuration window, right-click Forest then select Properties and then Voice 
Properties form the menu provided. Edit a location profile as shown in the following example:  
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Click Add or Edit to create or change a particular rule.  
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In this example, when a user dials any 4-digit number, it will be converted to its E.164 equivalent of 
+1716639xxxx and then that number will be searched for in AD. 
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More examples are shown in the following table: 
 

Name Phone Pattern Translation Pattern Comments 

Extensions ^(\d{4})$ +1716639$1 Internal extensions  

Local ^(\d{7})$ +1716$1 Local number 

National ^1(\d*)$ +1$1 Long distance number 

International ^011(\d*) +$1 International number 

 
A default route is used to route all calls to Microsoft® Mediation Server. If you need to route some calls to a 
different Microsoft® Mediation Server, configure the Target phone numbers field accordingly. 
 
To configure Microsoft® OCS, click  
Start > Programs > Administrative Tools > OCS 2007. 
 
On the tree presented in the configuration window, right-click Forest then select Properties and then Voice 
Properties form the menu provided. Edit a route as shown in the example below.  
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This entry routes numbers with or without “+” prefix followed by any digits to Microsoft® Mediation Server 
dmg4000.bufocs.local. 
 
Restart the Front End Services for the above changes to take effect, including all normalization rules. This can 
be done from the window Services. 
 
Note: Unless the dialed number from Microsoft® OCS client (such as Microsoft® Office Communicator) is in E.164 
format, Microsoft® OCS must find a normalization rule to convert the dialed number to E.164. If no rule is found 
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or matched, outbound calls will fail. In this case, Dialogic® Diva® Diagnostics trace will not receive an outbound 
SIP message, since the call will not yet have reached the SIP gateway. 
 
 
7.2 Steps for configuring Microsoft® Office Communications Server 2007 (OCS) 

clients  
 
The domain users need to be enabled for making calls through Microsoft® OCS. 
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Under the Communications tab, check the Enable user for Office Communications Server option 
and then click the Configure button. 

 
 
In the above configuration for the hypothetical user Ray Cassick, an inbound PSTN call for 3101 will be 
converted by the Dialogic® Diva® SIPcontrol™ Software to +17166393101 because in the Diva SIPcontrol 
software dialpan in the SIP Peer Configuration section under Address Normalization the: 

• Number format (outbound) is set to International number, and  
• Encoding (outbound) is set to Use type flag.  

 
Microsoft® OCS will ring the user Ray Cassick if he is logged on to Microsoft® OCS from Microsoft® Office 
Communicator or any Microsoft® OCS supported device. 
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8. Microsoft® Mediation Server Installation and Configuration 
 
8.1 Installation 

 
The gateways of the Dialogic® 4000 Media Gateway Series (DMG4000 Gateways) are shipped with pre-installed 
Microsoft® Mediation Server software. You can complete the Microsoft® Mediation Server configuration by 
running Microsoft® Office Communications Server 2007 (OCS) “Setup.exe” in the DMG4000 Gateways. In the 
Microsoft® OCS Deployment Wizard, select Deploy Other Server Roles, then select Deploy Mediation 
Sever. Follow the steps in the Wizard to complete the setup: 
 
Step 1: Install the Microsoft® Mediation Server software. 
 
Step 2: Activate Microsoft® Mediation Server. Use the existing account and enter the password for the service 
account. 
 
Step 3: No action needed. Do this step when the installation is complete. 
 
Step 4: Configure Certificate.  

1. Download the CA certification path for Microsoft® Mediation Server.  
• From Start > Run, enter http://<CA server>/certsrv 
• Select to download a CA certificate, chain or CRL. 
• Click Download CA certificate chain. 
• In File Download, click Save. 

2. Install the certificate chain for the Microsoft® Mediation Server: 
• In the Deployment Wizard, run step 4 again. 
• Select Import a certificate chain from a .p7b file in step 1.  

3. Verify that your CA is in the list of Trusted root CAs: 
• In the Microsoft® Management Console (MMC) snap-in, click Certificates (If not already 

done, add it.) 
• Verify that CA is on the list of trusted CAs as shown in the example below. 
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4. Create the certificate request for the Microsoft® Mediation Server: 
• Run Deployment Wizard, click step 4. 
• Select the option Create a new certificate. 
• Select the option Send the request immediately to an online CA. 
• Complete the settings in the blank. 
• Click Assign to complete the task. 

 
Note: If you receive the error message “certificate expired or is not yet valid” when you click the assign button at 
the end of step 4, check the time/time zone configured for your Microsoft®  Mediation Server is correct, then run 
the Deployment Wizard again or click Certificates in Available tasks in Microsoft® Mediation Server 
MMC snap-in. 
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8.2 Configuration 
 
From the MMC snap-in, right-click the detected Microsoft® Mediation Server and select Properties. 
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Configure the following settings on the General tab:  
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Click the Next Hop Connections tab and configure the following:  
 

 
 
The Port entry under PSTN Gateway Next hop has to match the configuration in the Dialogic® Diva® 
SIPcontrol™ Software under Network Interface Configuration > SIP Listen Port.  
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Click the Certificate tab.  
 

 
 
Select the certificate that will be used to communicate with Microsoft® OCS. Microsoft® Mediation Server will 
need to restart for these changes to properly take effect. 
 
9. Testing the Validation Matrix 
 
The table below shows various test scenarios that are run as typical validation scenarios if the Dialogic® Media 
Gateway is used in a voice messaging situation. The notes column specifies any notable parts of the test. 
 
The test scenarios below assume that all gateway configuration parameters are at their default values. For a 
sample showing call flows and states please consult the Gateway SIP Compatibility Guide. 
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Test 
Number 

Call Scenario Description Notes 

Inbound call scenarios 

1 Direct call from TDM station set to 
Microsoft® OCS client. 

 

2 Direct call from Microsoft® OCS client to 
TDM station set. 

 

 
 
10. Troubleshooting 
 
10.1 Important Debugging Tools 
 

• Ethereal/Wireshark: Can be used to view and analyze the network captures provided by the Dialogic 
gateway diagnostic firmware. 

• Adobe Audition: Can be used to review and analyze the audio extracted from the network captures to 
troubleshoot any audio related issues. 

• Dialogic® Diva® Diagnostics tool: Used to review and analyze all SIP and ISDN traffic that relates to 
calls going into and leaving the Dialogic® 4000 Media Gateway. 

 
10.2 Using the Dialogic® Diva® Diagnostics Tool 

 
Before using the Dialogic® Diva® Diagnostics tool, you would need to enable it by setting the Dialogic® Diva® 
SIPcontrol™ Software debug. To do so, open the Diva SIPcontrol software web interface, click the link System 
Settings, and set Debug Level to Extended. Click the Save button for the changes to take effect. 
 
Now, you can start the Diva Diagnostics tool. To do so, click:  
Start > Programs > Dialogic Diva > Diagnostics. 
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1. Click one line of your Dialogic® Diva® Media Board in the left pane and click  on the toolbar to activate 
the Basic tracing level. This level captures Q.931 ISDN messages.  
 

2. Click CAPI driver in the left pane and activate the Basic tracing level as explained in step 1. 
 

3. Start tracing. To do so, click the start icon  or select the Start Tracing option form the Tracing 
menu. 
 

4. Reproduce the issue. 
 

5. To stop tracing, click the stop icon  on the tool bar or select the Stop Tracing option form the 
Tracing menu. 

 

6. To view your collected trace, click the view icon  on the toolbar or select the View Recorded 
Trace option from the View menu. A notepad window will open with the recorded log. 
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Examples of Dialogic® Diva® Diagnostics traces for an inbound (TDM to IP) call to Microsoft® Office 
Communications Server 2007 (OCS) 
 
Basic notations for reading the trace: 
 

• SIG-R: RX Q.931 ISDN message 
• SIG-X: TX Q.931 ISDN message 
• SIPR: RX SIP message 
• SIPX: TX SIP message 

 
< Below is a RX Q.931 ISDN message for an inbound call > 
… 
9:16:28.431 C  3 21:2389:383 - SIG-R(030) 08 02 00 17 05 04 03 80 90 A2 18 03 A9 83 81 6C 06 01 A0 33 
30 30 32 70 05 C1 35 31 30 31 
                     Q.931  CR0017 SETUP 
                            Bearer Capability 80 90 a2 
                            Channel Id a9 83 81 
                            Calling Party Number 01 a0 '2401' 
                            Called Party Number c1 '5101' 
 
… 

<Below is a TX SIP message with SDP> 
 
9:16:28.431 1 L 12 00010000-SIPX begin to IP:192.168.0.106 port:5060 socket:3 Proto:TCP 
 9:16:28.431 1 L 12 00010000-    >INVITE sip:+17166395101@dmg4000.bufocs.local:5060 SIP/2.0 
 9:16:28.431 1 L 12 00010000-    >Via: SIP/2.0/TCP 192.168.0.106:9803;branch=z9hG4bK2617534104-7603272 
 9:16:28.431 1 L 12 00010000-    >Max-Forwards: 70 
 9:16:28.431 1 L 12 00010000-    >Allow: INVITE,ACK,CANCEL,BYE,OPTIONS,NOTIFY,REFER 
 9:16:28.431 1 L 12 00010000-    >Accept: application/sdp,application/simple-message-summary 
 9:16:28.431 1 L 12 00010000-    >Supported: timer,replaces 
 9:16:28.431 1 L 12 00010000-    >From: "Dialogic Diva SIPcontrol" 
<sip:+17166392401@192.168.0.106;user=phone>;tag=sipcontrol_2617534104-7668808 
 9:16:28.431 1 L 12 00010000-    >To: "Default" <sip:+17166395101@bufocs.local;user=phone> 
 9:16:28.431 1 L 12 00010000-    >Call-ID: 9c046698-730448-17@dmg4000 
 9:16:28.431 1 L 12 00010000-    >CSeq: 1 INVITE 
 9:16:28.431 1 L 12 00010000-    >Min-SE: 90 
 9:16:28.431 1 L 12 00010000-    >Session-Expires: 600;refresher=uac 
 9:16:28.431 1 L 12 00010000-    >Contact: <sip:+17166392401@192.168.0.106:9803> 
 9:16:28.431 1 L 12 00010000-    >Content-Type: application/sdp 
 9:16:28.431 1 L 12 00010000-    >Content-Length: 253 
 9:16:28.431 1 L 12 00010000-    > 
 9:16:28.431 1 L 12 00010000-    >v=0 
 9:16:28.431 1 L 12 00010000-    >o=SIPcontrol 7472200 7472200 IN IP4 192.168.0.106 
 9:16:28.431 1 L 12 00010000-    >s=- 
 9:16:28.431 1 L 12 00010000-    >c=IN IP4 192.168.0.106 
 9:16:28.431 1 L 12 00010000-    >t=0 0 
 9:16:28.431 1 L 12 00010000-    >m=audio 30060 RTP/AVP 8 0 101 13 
 9:16:28.431 1 L 12 00010000-    >a=rtpmap:8 PCMA/8000 
 9:16:28.431 1 L 12 00010000-    >a=rtpmap:0 PCMU/8000 
 9:16:28.431 1 L 12 00010000-    >a=rtpmap:101 telephone-event/8000 
 9:16:28.431 1 L 12 00010000-    >a=fmtp:101 0-15 
 9:16:28.431 1 L 12 00010000-    >a=rtpmap:13 CN/8000 
 9:16:28.431 1 L 12 00010000-    >a=sendrecv 
 9:16:28.431 1 L 12 00010000-SIPX end 
… 
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<Below is a RX SIP message> 
 
9:16:28.431 1 L 12 00010000-SIPR begin (331 byte) from IP:192.168.0.106 PORT:5060 on socket 3 port 5060 
TCP 
 9:16:28.431 1 L 12 00010000-    >SIP/2.0 100 Trying 
 9:16:28.431 1 L 12 00010000-    >FROM: "Dialogic Diva 
SIPcontrol"<sip:+17166392401@192.168.0.106;user=phone>;tag=sipcontrol_2617534104-7668808 
 9:16:28.431 1 L 12 00010000-    >TO: "Default"<sip:+17166395101@bufocs.local;user=phone> 
 9:16:28.431 1 L 12 00010000-    >CSEQ: 1 INVITE 
 9:16:28.431 1 L 12 00010000-    >CALL-ID: 9c046698-730448-17@dmg4000 
 9:16:28.431 1 L 12 00010000-    >VIA: SIP/2.0/TCP 192.168.0.106:9803;branch=z9hG4bK2617534104-7603272 
 9:16:28.431 1 L 12 00010000-    >CONTENT-LENGTH: 0 
 9:16:28.431 1 L 12 00010000-    > 
 9:16:28.431 1 L 12 00010000-SIPR end 
… 
9:16:28.665 0 L 12 00010000-SIPR begin (408 byte) from IP:192.168.0.106 PORT:5060 on socket 3 port 5060 
TCP 
 9:16:28.665 0 L 12 00010000-    >SIP/2.0 183 Session Progress 
 9:16:28.665 0 L 12 00010000-    >FROM: "Dialogic Diva 
SIPcontrol"<sip:+17166392401@192.168.0.106;user=phone>;tag=sipcontrol_2617534104-7668808 
 9:16:28.665 0 L 12 00010000-    >TO: 
Default<sip:+17166395101@bufocs.local;user=phone>;epid=CE4C602FA5;tag=3f5ea65423 
 9:16:28.665 0 L 12 00010000-    >CSEQ: 1 INVITE 
 9:16:28.665 0 L 12 00010000-    >CALL-ID: 9c046698-730448-17@dmg4000 
 9:16:28.665 0 L 12 00010000-    >VIA: SIP/2.0/TCP 192.168.0.106:9803;branch=z9hG4bK2617534104-7603272 
 9:16:28.665 0 L 12 00010000-    >CONTENT-LENGTH: 0 
 9:16:28.665 0 L 12 00010000-    >SERVER: RTCC/3.0.0.0 MediationServer 
 9:16:28.665 0 L 12 00010000-    > 
 9:16:28.665 0 L 12 00010000-SIPR end 
… 
9:16:28.869 1 L 12 00010000-SIPR begin (399 byte) from IP:192.168.0.106 PORT:5060 on socket 3 port 5060 
TCP 
 9:16:28.869 1 L 12 00010000-    >SIP/2.0 180 Ringing 
 9:16:28.869 1 L 12 00010000-    >FROM: "Dialogic Diva 
SIPcontrol"<sip:+17166392401@192.168.0.106;user=phone>;tag=sipcontrol_2617534104-7668808 
 9:16:28.869 1 L 12 00010000-    >TO: 
Default<sip:+17166395101@bufocs.local;user=phone>;epid=CE4C602FA5;tag=3f5ea65423 
 9:16:28.869 1 L 12 00010000-    >CSEQ: 1 INVITE 
 9:16:28.869 1 L 12 00010000-    >CALL-ID: 9c046698-730448-17@dmg4000 
 9:16:28.869 1 L 12 00010000-    >VIA: SIP/2.0/TCP 192.168.0.106:9803;branch=z9hG4bK2617534104-7603272 
 9:16:28.869 1 L 12 00010000-    >CONTENT-LENGTH: 0 
 9:16:28.869 1 L 12 00010000-    >SERVER: RTCC/3.0.0.0 MediationServer 
 9:16:28.869 1 L 12 00010000-    > 
 9:16:28.869 1 L 12 00010000-SIPR end 
… 
9:16:30.197 1 L 12 00010000-SIPR begin (836 byte) from IP:192.168.0.106 PORT:5060 on socket 3 port 5060 
TCP 
 9:16:30.197 1 L 12 00010000-    >SIP/2.0 200 OK 
 9:16:30.197 1 L 12 00010000-    >FROM: "Dialogic Diva 
SIPcontrol"<sip:+17166392401@192.168.0.106;user=phone>;tag=sipcontrol_2617534104-7668808 
 9:16:30.197 1 L 12 00010000-    >TO: 
Default<sip:+17166395101@bufocs.local;user=phone>;epid=CE4C602FA5;tag=3f5ea65423 
 9:16:30.197 1 L 12 00010000-    >CSEQ: 1 INVITE 
 9:16:30.197 1 L 12 00010000-    >CALL-ID: 9c046698-730448-17@dmg4000 
 9:16:30.197 1 L 12 00010000-    >VIA: SIP/2.0/TCP 192.168.0.106:9803;branch=z9hG4bK2617534104-7603272 
 9:16:30.197 1 L 12 00010000-    >CONTACT: 
<sip:dmg4000.BufOCS.local:5060;transport=Tcp;maddr=192.168.0.106> 
 9:16:30.197 1 L 12 00010000-    >CONTENT-LENGTH: 253 
 9:16:30.197 1 L 12 00010000-    >SUPPORTED: 100rel 
 9:16:30.197 1 L 12 00010000-    >CONTENT-TYPE: application/sdp; charset=utf-8 
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 9:16:30.197 1 L 12 00010000-    >ALLOW: UPDATE 
 9:16:30.197 1 L 12 00010000-    >SERVER: RTCC/3.0.0.0 MediationServer 
 9:16:30.197 1 L 12 00010000-    >ALLOW: Ack, Cancel, Bye,Invite 
 9:16:30.197 1 L 12 00010000-    > 
 9:16:30.197 1 L 12 00010000-    >v=0 
 9:16:30.197 1 L 12 00010000-    >o=- 0 0 IN IP4 192.168.0.106 
 9:16:30.197 1 L 12 00010000-    >s=session 
 9:16:30.197 1 L 12 00010000-    >c=IN IP4 192.168.0.106 
 9:16:30.197 1 L 12 00010000-    >b=CT:1000 
 9:16:30.197 1 L 12 00010000-    >t=0 0 
 9:16:30.197 1 L 12 00010000-    >m=audio 62438 RTP/AVP 8 101 
 9:16:30.197 1 L 12 00010000-    >c=IN IP4 192.168.0.106 
 9:16:30.197 1 L 12 00010000-    >a=rtcp:62439 
 9:16:30.197 1 L 12 00010000-    >a=label:Audio 
 9:16:30.197 1 L 12 00010000-    >a=rtpmap:8 PCMA/8000 
 9:16:30.197 1 L 12 00010000-    >a=rtpmap:101 telephone-event/8000 
 9:16:30.197 1 L 12 00010000-    >a=fmtp:101 0-16 
 9:16:30.197 1 L 12 00010000-    >a=ptime:20 
 9:16:30.197 1 L 12 00010000-SIPR end 
… 

<Bellow is a TX Q.931 ISDN message, after SIP session is established> 
 
9:16:30.212 C  3 21:2391:136 - SIG-X(005) 08 02 80 17 07 
                     Q.931  CR8017 CONN 
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